Digital Video Recorder

DSR-3716PA
DSR-3709PA
DSR-3706PA

Manual for Remote Operations using a Network Connection
# Table of Contents

1. **Introduction** .................................................. 2
    - Features of Network Operation ........................................ 2
    - Operating Environment .................................................. 2
2. **Network Connection Procedure** .................................. 3
    1. NETWORK SET Settings of DVR ........................................ 3
    2. TCP/IP Settings of the Computer ...................................... 3
    3. Network Operation Screen Display .................................... 5
    4. Network Connection Restrictions ...................................... 6
    5. Change to DVR Operation .............................................. 6
3. **Organization of the Main Screen and Functions of Each Part** ............ 7
    1. Functions of Main Screen and Operation Authority ................. 7
    2. Operating mode display panel .......................................... 9
4. **View Live Video** .................................................. 10
    1. Change display pattern of live video ................................ 10
    2. Set the display mode for images ..................................... 11
    3. Playback audio ....................................................... 11
5. **Recording Monitored Images** ..................................... 12
    1. Normal Recording (Normal Recording Area) ......................... 12
    2. Other Recording Methods ............................................. 12
6. **View Recorded Images** ............................................ 13
    1. Playback Recorded Images ............................................. 13
    2. Basic Playback Operations ............................................ 13
7. **Search Recorded Images** .......................................... 14
    1. Search Screen Selection .............................................. 14
    2. ALARM SEARCH ....................................................... 14
    3. TIME/DATE SEARCH ................................................... 15
    4. ARCHIVE AREA SEARCH ............................................... 15
    5. MOTION DETECTION SEARCH ........................................... 16
8. **Saving Images** .................................................... 17
    1. Saving live video on the computer .................................. 17
    2. Copying Recorded Images to the DVR’s Archive Area .............. 18
    3. Downloading Recorded Images to the Computer ...................... 19
    4. Saving Format for Image Files ...................................... 20
9. **Operating a Dome Camera** ........................................ 21
10. **Setting up the Basic Menu** ....................................... 22
    1. Using Network Operations ............................................ 22
    2. Basic Settings Menu Outline .......................................... 22
    3. Basic menu setting procedure ........................................ 23
11. **Initial setting** .................................................... 24
    1. CLOCK SET .......................................................... 24
    2. SUMMER TIME SET/EXT. CLOCK SET .................................. 24
    3. HOLIDAY SET ........................................................ 24
12. **Recording settings** ............................................... 25
    1. ARECORDING AREA SET .............................................. 25
    2. RECORONDING CONDITIONS SET ....................................... 26
    3. NORMAL REC MODE SET ............................................... 27
    4. PROGRAM REC SET ................................................... 28
    5. TIMER SET .......................................................... 28
    6. ALARM REC MODE SET ............................................... 30
13. **General settings** .................................................. 32
    1. DISPLAY SET ........................................................ 32
    2. BUZZER SET ........................................................ 32
    3. HDD SET ........................................................... 33
    4. NETWORK SET ....................................................... 34
    5. RS-485 SET ........................................................ 34
14. **Screen settings and DVR information** ................................ 35
    1. MASK SET .......................................................... 35
    2. POWER LOSS/USED TIME ............................................. 35
    3. INITIALIZATION LOG ................................................ 35
15. **DVR Viewer2** ..................................................... 36
    1. Operating Environment ................................................ 36
    2. Installing the Viewer Software ....................................... 36
    3. Internet Option Settings ............................................. 36
    4. Running and Quitting Viewer ......................................... 36
    5. Structure of the Screen and the Function of each Section .......... 37
    6. Opening image Files ................................................ 38
    7. Switching the Display Pattern of the Screen ....................... 39
    8. Selecting the Channel Displayed on the Screen ..................... 39
    9. Functions of the Viewer Operating Panel ............................ 40
    10. Saving and Printing Images ......................................... 41
    11. Setting the Date and Time Display Format .......................... 41

---

English 1
Introduction

Connect the computer and digital video recorder (DVR) using a LAN. The DVR can be operated from the computer through the network.

Features of Network Operation
- It allows to remotely control the settings of the DVR, operating conditions and monitoring of live video as well as standard functions such as recording and playback using the Web browser of the computer.
- Up to four computers can access one DVR at the same time.
- The operation rights of users can be set at three levels. A password is used to connect to ensure full security.
- You can freely switch between DVR operation and network operation.
- Switching the display screen of a computer or using operations such as playback will not effect the monitored image of the DVR.

Operating Environment
- CPU: Pentium® IV (2 GHz) or higher
- RAM: 256 MB or more (512 MB or more recommended)
- Compatible OS: Windows 2000/XP
- Compatible machines: PC/AT machines operating with the above OS
- Display: Color (SVGA more than 65536 colors)
- Audio: Sound card and speakers compatible with DirectX
- Browser: Internet Explorer Ver. 5.5 SP2 or higher

Copyright information
This manual is work of Sanyo Electric Co., Ltd. Windows and Internet Explorer are trademarks or registered trademarks of Microsoft Corporation USA in the USA and in other countries. Pentium is a trademark or registered trademark of Intel Corporation USA and associated companies in the USA and in other countries. IBM and IBM PC/AT are trademarks of IBM International Business Machines Corporation USA. All other brands and trade names used in this manual are trademarks or registered trademarks of each company.
Network Connection Procedure

To operate the DVR through a network, first setup the DVR and computer and then perform the predetermined connection operations using the computer.

1 NETWORK SET Settings of DVR
Select NETWORK SET from the main menu of the DVR and make the following settings to allow the DVR to work with a network connection. Refer to the instruction manual of the DVR for details.

| NETWORK SET | NETWORK CONTROL: OFF | NETWORK STATUS: ON | IP ADDRESS: 192.168.0.1 | SUBNET MASK: 255.255.255.0 | GATEWAY: 0.0.0.0 | PORT: 8080 | ID1 PASSWORD: 1111- | ID2 PASSWORD: 2222- | ID3 PASSWORD: 3333- |

1 NETWORK CONTROL
To use network operation change to “ON (NETWORK)” or “ON (DVR)”.
Selections:
- ON (NETWORK):
  Gives priority to network operations and allows all users (ID1 to ID3) to access.
- ON (DVR):
  Gives priority to DVR operations and limits the users who can access the network to ID1 users only.
- OFF:
  Network operations are not allowed.

2 NETWORK STATUS
Sets whether or not the “NETWORK CONTROL” message will display on the monitor connected to the DVR when connected to the network.

3 IP ADDRESS/SUBNET MASK/GATEWAY
Set each item in a range of 0 to 255. Ask the network administrator for IP addresses and subnet masks required to set the network.

4 PORT
Normally set to “80”.

5 ID/PASSWORD
An individual PASSWORD can be set according to the operation authority.

TCP/IP Settings of the Computer
Setup TCP/IP according to each OS for the computer being used.

1 Click [Network and Internet Connections] of [Control Panel].
The “Network and Internet Connections” screen will display:

2 Click [Network Connections].
The "Network Connections" screen will display. The settings of the LAN card being used (Ethernet adapter) display in the [LAN or High-Speed Internet] column.
Network Connection Procedure

3. Right click the settings of the LAN card being used (Ethernet adapter) and select [Properties] from the menu. The [General] tab of [Local Area Connection Properties] will display.

4. Select [Internet Protocol (TCP/IP)] from the list of [This connection uses the following items]. Confirm that [Internet Protocol (TCP/IP)] is checked. If it is not checked, add a check mark.


6. Select [Use the following IP address] and then enter an IP address and subnet mask.

7. Confirm the setting contents and click [OK]. This ends the TCP/IP settings. Close all displayed dialog boxes.
Network Connection Procedure

3 Network Operation Screen Display

When the DVR and computer settings are complete, start the Web browser on the computer. The browser should be Internet Explorer Ver. 5.5 SP2 or higher.

If the computer accesses the DVR following the procedure below, the screen will change to the network operation screen.

1 Enter the connection URL in the address bar of the browser.

| Address | http://192.168.0.1/ |

Enter the DVR IP address set in NETWORK SET after http:// and press the [Enter] key. The authentication check dialog box will display.

When PORT is set to a different value from the initial "80" append a colon (:) and a PORT number after the IP address.

<Example when setting PORT to 81>

http://192.168.0.1:81/

2 Enter the user name and password and then click OK.

If the user name and password are entered correctly, the connection to the DVR will complete and the language selection screen will display.

3 Select a display language from the network operation screen and click OK.

The screen will switch to the main screen and network operations from the computer will be enabled.

Language selection:

English, French, German, Spanish

• Concerning the time setting of the DVR

If the current date and time are not set properly on the DVR, basic operations such as normal recording, timer controlled recording, camera control will not be available. It will also hinder the setting of other menus related to time and date. Therefore, please verify whether the current date and time are properly set on the DVR using the CLOCK SET screen. (Refer to P24)

• If [NETWORK STATUS] is "ON" in NETWORK SET of this device when changing to network operation, the message "NETWORK CONTROL" will be displayed on the screen of the monitor connected to the DVR.

• When "Run Time Error" of Java Script displays while using Internet Explorer

Select the menus in the following order [Tools] → [Internet Options] → [Advanced Settings] and then remove the check mark of "Display notification for each script error" in the browser settings. Check "Do not use script debugging".

• When a portion of the image is not displayed due to performance or specifications of the computer.

Within Internet Explorer select from the menus in the following order [Tools] → [Internet Options] → "Temporary Internet Files" and then set [Amount of disk space to use] to less.
Network Connection Procedure

Network Connection Restrictions
Connections are restricted depending on the connections state of users and the content of the network settings. If a DVR cannot be connected, confirm whether the connection falls under the following restrictions.

Restrictions on the number of simultaneous connected users
There is a limit to the number of users who can connect simultaneously.
When a connection is not possible due to restrictions on the number of simultaneous connections, the message "THE UNIT IS BUSY!" will display.
1. Up to four users can connect simultaneously to one DVR.
2. Only one user of either ID2 or ID3 can connect.
3. When a connection is duplicated, the user with the higher user level will take precedence.
   Example:
   • If an ID1 user attempts to connect at the same time as four other ID1 users, the connection will not be allowed.
   • If an ID2 user attempts to connect at the same time as four other ID1 users, the ID1 user who connected last will be disconnected and the ID2 user will be allowed to connect in the ID1 users' place.
   • If an ID3 user attempts to connect at the same time as three other ID1 users and an ID2 user, since ID2 and ID3 users are not able to connect simultaneously, the ID2 user will be disconnected and the ID3 user will be allowed to connect in the ID2 user's place.

Restrictions determined by network settings
Connection is restricted by the [NETWORK CONTROL] settings of NETWORK SET of the DVR.
When a connection is not possible due to operation restrictions established by NETWORK SET or the operating state of the DVR, the message "THE UNIT IS NOT READY!" will display.
1. When "ON (NETWORK)" is selected.
   • All users (ID1 to ID3) can connect.
   • Cannot connect during DVR playback, camera control, and while displaying menu screens.
2. When "ON (DVR)" is selected.
   • Only user level ID1 can connect. Only monitoring of live video on the computer is possible.
   • Cannot connect while the DVR is in playback operation.
   • If the playback operation is performed by the DVR when connected, the connection will be automatically disconnected.
3. When "OFF" is selected.
   Cannot connect to DVR.

Change to DVR Operation
If the disconnect button on the operation panel is clicked, the network connection will disconnect and the DVR can be operated.
When the connection is disconnected, the message "THE UNIT IS DISCONNECTED!" will display.

• If the browser is closed without clicking the disconnect button, approximately 1 minute will pass until reconnecting.
• When [NETWORK CONTROL] of NETWORK SET of the DVR is set to "ON (NETWORK)", press the [EXIT/OSD] button for at least 2 seconds. The connection can be forcibly disconnected from the DVR. The connection will not be accepted from the computer for 10 seconds after a forced disconnect.
• When communication with the computer is cut off for approximately 1 minute or more, the connection will automatically disconnect and switch to DVR operation.
• The connection will automatically disconnect when the settings of NETWORK SET of the DVR are changed while connected.
Organization of the Main Screen and Functions of Each Part

The main screen will display when the network connection is completed. The main screen consists of three panels. The operation panel is where you can perform basic operations, such as monitoring live video, recording, and playback.

Organization of Main Screen

1. Operation panel (Refer to P8)
   In the operation panel, you can execute basic functions of network operation at the touch of one button, such as selecting a display channel or screen pattern, playback and recording, or changing to other operation screens. The operation panel is always displayed even if you change from the main screen to other operation screens.

2. Operating mode display panel (Refer to P9)
   This panel displays information related to display images and the operating state of the DVR.

3. Image display panel (Refer to P10)
   This panel displays live video and playback images. The display pattern (full screen/quad-screen/multi-screen) of the screen can be changed using the buttons on the operation panel.
   An image setting menu and a save button display at the lowermost portion of the image display panel.
   The displayed menu and button change depending on the display pattern of the screen and button operation as shown in "Menu display of image display panel". (Refer to the figure on the right)

Menu display of image display panel

- **Quad-screen/multi-screen**
  - Display speed, size, and image quality settings (Refer to P11)

- **Full screen**
  - Display speed, size, and image quality settings (Refer to P11)
  - Audio playback (Refer to P11)
  - Dome camera operation (Refer to P21)
  - Saving live video to the computer (Refer to P17)

Setting menu for saving

Setting [SAVE TO PC] (D) to "ON" and clicking on [SET] displays the saving set menu.
Organization of the Main Screen and Functions of Each Part

1. Functions of Operation Panel and Operation Authority

Click a button on the operation panel to perform operation through the network from the computer.

- The organization of the buttons on the operation panel differs depending on the DVR model.
- The button operations are restricted according to the level of the connected users. User levels which can operate the buttons are displayed in ( ). (Refer to P34)

2. Channel selection button (ID1/2/3)

Click to display on full screen.

The layout of the buttons varies according to the DVR model.

16-channel model: 
9-channel model: 

3. Channel display box

The selected channel number is displayed.

4. Screen select button (ID1/2/3)

Click to change the screen for a 9/16-channel model.

- Change to quad-screen
- Change to multi-screen (9/16 split screens).

Click to change the screen for a 6-channel model.

- Change to multi screen (6 split screens).

5. Playback operation button (ID2/3)

- Skip to previous alarm
- Skip to next alarm
- Increase playback speed
- Reduce playback speed
- Reverse playback

Displays a live video if is clicked during playback or while another operation screen is displayed.

6. Image search button (ID2/3)

- Change to SEARCH menu screen

7. Save operation button (ID2/3)

- Change to COPY screen
- Change to DOWNLOAD screen

8. Record operation button (ID3)

- Start normal recording
- Stop normal recording
- Change the timer controlled recording function

9. Menu button (ID3)

- Change to MAIN MENU screen

10. Disconnect button (ID1/2/3)

- Disconnect the connection with the DVR and change from network operation to DVR operation.
Organization of the Main Screen and Functions of Each Part

2 Operating mode display panel
Information required for network operation is displayed in this panel in response to the display image.

A For live video

1 Image classification
"LIVE" is displayed.
2 Date and time
Current date and time are displayed.
3 NORMAL RECORDING MODE
The operating mode of normal recording for the DVR is displayed.
- STOP (stop recording state)
- RECORDING (while recording)
- TIMER STANDBY (during a timer recording standby)
- TIMER RECORDING (during timer recording)
- AREA FULL [OVERWRITE] is set to "OFF" and the normal recording area is full.

4 ALARM RECORDING MODE
The operating mode of alarm recording for the DVR is displayed.
- STOP (stop recording state)
- PRE ALARM RECORDING (during pre-alarm recording)
- ALARM RECORDING (during alarm recording)
- AREA FULL [OVERWRITE] is set to "OFF" and the alarm recording area is full.

5 Connection information of user
When multiple users connect simultaneously, the number of connected users will be displayed according to the level of each user.
(Display example) ID1: 3 ID2: 1 ID3: 0
Your own user ID during the current operation is displayed in red.

B When playing back images

1 Image classification
"PLAY" is displayed.
2 Date and time
The recording date and time (time stamp) of the image currently being played back is displayed.
3 NORMAL RECORDING MODE
The operating state of normal recording for the DVR is displayed. (Display content is the same as a live video.)
4 ALARM RECORDING MODE
The operating state of alarm recording for the DVR is displayed. (Display content is the same as a live video.)
5 PLAYBACK AREA
The recording area of the image currently being played back is displayed.
- NORMAL (normal recording area)
- ALARM (alarm recording area)
- PRE ALARM (pre-alarm recording of alarm recording area)
- ARCHIVE (archive area)
6 SPEED
The operating mode used during playback is displayed.
- PLAY (playback)
- STILL (pause)
- R. PLAY (reverse playback)
- CUE (fast forward)
- REVIEW (fast reverse)
- SLOW (slow motion playback)
- R. SLOW (reverse slow motion playback)
View Live Video

If you change to network operation, live video will be automatically displayed in the image display panel of the main screen. Click  in the operation panel during playback or when another operation screen is displayed.

1 Change display pattern of live video (ID1/2/3)
The display pattern of live video can be selected from full screen (specific channel), quad-screen, or multi-screen.

(16-channel model)

(9-channel model)

(6-channel model)

1 Full screen viewing
Click the channel selection button or click on a channel image in the quad-screen or multi-screen. The specified channel image will display in full screen.

2 Quad-screen viewing
(Only corresponds to 9/16-channel model)
Click . Displays the camera image connected to the DVR every four channels in order of the channel number. The screen pattern changes each time  is clicked.

- 16-channel model

- 9-channel model

- 6-channel model

3 View multi-screen (6/9/16 screens)
Click or . Display image in multi-screen of 6/9/16 screens in response to the model of DVR.

On the 16-channel model, clicking switches the screen alternately from the 16 screen to the 9 screen.

- 16-channel model

- 9-channel model

- 6-channel model

- Camera images are assigned in order of channel number in a multi-screen. (It is not affected by the SCREEN SET of the DVR)
- The audio can only be played back when full screen is used.
- The image display speed in the quad-screen and multi-screen differs depending on the network environment.

For a 6 channel DVR, the quad-screen will not display. Select from two patterns; full screen and multi-screen.
View Live Video

2 Set the display mode for images (ID1/2/3)
You can set the display mode for live video and played back images. Select a setting value from the pull-down menu of each item and click [SET].

1. READ INTERVAL (Initial setting: 1)
   The display speed for images can be selected in five levels. The larger the numeric value, the faster the speed. The actual display speed is influenced by the network environment.
   - The display speed cannot be set when [AUDIO] is set to “ON”.

2. SIZE (Initial setting: 1)
   The image display size can be selected from six levels. The larger the numeric value, the larger the image.

3. QUALITY (Initial setting: 2)
   The image quality of live video can be selected in three levels. The selected image quality is applied to all channel images connected to the DVR.

   Selections:
   1: Low image quality
   2: Standard image quality
   3: High image quality
   - Because image quality cannot be selected when playing back images, the setting menu for [QUALITY] is not displayed.

3 Playback audio (ID2/3)
You can playback live and audio of reproduced audio at the same time.
When playing back audio, be sure the optional application software “DVR Viewer2 (Ver.2.0.0 or higher)” is installed on the computer beforehand. (Refer to P36)

1 Click the channel selection button. The screen will become the full screen display and the setting menu for [AUDIO] will display.
2 Set [AUDIO] to “ON”. Audio data is played back after being buffered for a fixed time. When [AUDIO] is set to “ON”, simultaneously select a buffering time.

   Selections:
   - OFF (initial setting)
   - ON-5/10/15/20/30 (seconds)

3 Click [SET]. The audio of the image will playback.

   - The audio cannot be played back in the quad-screen and multi-screen.
   - When playing back images with audio attached, the audio will take precedence and playback. Because of this, there is also a possibility that the images will not display depending on the environment.

What is buffering?
Buffering reads data in advance and saves a certain amount.
If the buffering time is set to be long, the playback quality will improve but time lags (delays) in the audio will occur.
You can record images while they are being monitored onto the hard disk of the DVR. There are four methods to record, normal recording, timer-controlled recording, alarm recording and pre-alarm recording. The stored images are recorded on each recording area in response to the operation.

- Because all connected camera images are recorded by the corresponding DVR, the channel cannot be specified.
- If the clock of the DVR is not set, it is not possible to record. (Refer to P24)

Normal Recording
(Normal Recording Area)
Records images being monitored using the manual operation on the operation panel.

1. Click .
   The display [NORMAL RECORDING MODE] in the operating mode display will change to "RECORDING" and recording will start.

2. Click when the recording stops.
   The display [NORMAL RECORDING MODE] will change to "STOP" and recording will stop.

Other Recording Methods
Set the recording conditions in the DVR setting menu. Refer to the applicable pages for details.

- Timer-controlled recording (normal recording area)
  Images being monitored are automatically recorded according to the timer setting. (Refer to P28)

- Alarm recording (alarm recording area)
  Uses signals from motion sensors and external devices (such as door switches and infrared sensors) to automatically record alarm images (such as intruders). (Refer to P30)

- Pre-alarm recording (alarm recording area)
  If pre-alarm recording is set, the most recent images of a fixed time will constantly be recorded in the alarm recording area while being repeatedly overwritten. You can view images which occur just before an alarm when playing back alarm recordings. (Refer to P30, 31)
View Recorded Images

You can freely playback images recorded in the DVR. There is no effect on the recording operation of the DVR even when playing back recordings.

**Playback Recorded Images**

1. Click \( \text{Play (or Stop)} \) in the operation panel.
   The image classification in the operating mode display panel changes to “PLAY” and the recorded images are played back in the image display panel.

2. Adjust the direction and speed of the playback in the operation panel.
   1. **To playback/reverse playback**
      Click \( \text{Play (or Stop)} \) during playback.
   2. **Adjust the playback speed**
      Click \( \text{Fast Forward (or Reverse)} \) during playback. Adjusting the playback speed allows you to fast forward, fast reverse, and playback in slow motion.
   3. **Still images**
      Click \( \text{Frame Advance} \) during playback. Clicking once again when a still image is displayed will return to normal playback.
   4. **Moving to next frame advance (forward/reverse)**
      Click \( \text{Frame Advance} \) during playback.
   5. **To skip an alarm**
      Click \( \text{Alarm} \) during playback. Skip the alarm image that occurs immediately after or immediately before.
   6. **To stop playback**
      Click \( \text{Stop} \).

3. Click \( \text{Stop} \) when the playback stops.
   The image classification changes to “LIVE” and returns to the live video.

**Basic Playback Operations**

- All images recorded in the normal recording area and alarm recording area (normal, timer, alarm, pre-alarm) during a normal playback operation are targeted for playback.
- Use the search function to search for and playback images. (Refer to P14)
- The playback order is in order from the oldest recorded event.
- Continues to playback from the last playback end point when played back one time.
- The display pattern (full screen/quad-screen/multi-screen) of the playback screen can be freely changed. Playback images of multiple connected cameras can be viewed simultaneously in a quad-screen or multi-screen.

- There is a possibility that the image will be corrupted if normal recording and alarm recording are continuously played back.
- When an alarm recording operates during a playback or when a fast forward or fast reverse is used while playing back a normal recording or an alarm recording, there is a possibility that the movement of the image will momentarily stop.
You can search and playback specific images from image data recorded in each recording area of the DVR.

(Search menu)
The following five search menus are available in accordance with the search objective.

- **ALARM SEARCH**
  Uses a list (alarm number, recording date/time, channel number) to search and playback images recorded in an alarm recording area.

- **ALARM THUMBNAIL SEARCH**
  Uses thumbnails to search and playback images recorded in an alarm recording area.

- **TIME/DATE SEARCH**
  Among the images recorded in the normal and alarm recording areas, specify the date and time and the channel of the recording, search and play the recording back.

- **ARCHIVE AREA SEARCH**
  Uses a list (image number, recording date/time, channel number) to search and playback images saved in the archive area.

- **MOTION DETECTION SEARCH**
  Sets the motion sensor to images recorded in the normal recording area and the alarm recording area and then searches and plays back images with movement.

### Search Screen Selection

1. **Click ![Image search button](image.png) in the operation panel.**
   The search menu screen displays.

   ![Image search button](image.png)

   You cannot change from the playback image to the search menu screen.

2. **Select the search menu and click.**
   Changes to the selected search screen.

   ![SEARCH](image.png)

   1. ALARM SEARCH
   2. ALARM THUMBNAIL SEARCH
   3. TIME/DATE SEARCH
   4. ARCHIVE AREA SEARCH
   5. MOTION DETECTION SEARCH
Search Recorded Images

(User level: ID2/3)

3 TIME/DATE SEARCH

1 Click "3. TIME/DATE SEARCH" in the search menu.
The TIME/DATE SEARCH screen displays.

2 Specify channel.
You can specify a channel to narrow the search range.
Select "---" when a channel (camera number) is not specified.

3 Specify the recording date and time for the image you want to play back.
The start and stop date/time of the image recorded in the DVR are displayed in [RECORDING TOP] and [RECORDING END]. Specify "day/month/year/hour/minute" in this range.

4 Click .
The image of the specified date and time is displayed in the PREVIEW screen as a still image.
When you want to change the preview screen, repeat the same operations (procedures 2 to 3).

5 Click PREVIEW screen.
Change to main screen and playback images. You can perform normal playback operations after playback starts.

4 ARCHIVE AREA SEARCH

1 Click "4. ARCHIVE AREA SEARCH" in the search menu.
The ARCHIVE AREA SEARCH screen displays.

2 Click the image number of the list.
The first image of the applicable saved images is displayed as a still image in the PREVIEW screen.

3 Click PREVIEW screen.
Change to main screen and playback images. You can perform normal playback operations after playback starts.

- Recorded events are displayed in a list in order from the oldest in the save history up to eight items. Use the [BACK] or [NEXT] buttons to change to the previous page and the next page.
- The total capacity and the used capacity of the archive area are displayed, for reference, in the upper right corner of the screen.

English 15
Search Recorded Images

(User level: ID2/3)

5 MOTION DETECTION SEARCH

1. Click "5. MOTION DETECTION SEARCH" in the search menu.
   The MOTION DETECTION SEARCH screen displays.

2. Specify a search area using "SEARCH FROM".
   Select the recording area targeted for the search.
   Selections:
   - ALARM (alarm recording area)
   - NORMAL (normal recording area)
   - ALARM AND NORMAL (Alarm/normal recording area)

3. Specify [CHANNEL].
   You can specify a channel to narrow the search range.
   Select "-" when a channel is not specified.

4. Specify an image range to search.
   The start and stop date/time of the image recorded in the DVR are displayed in [START] and [END].
   Change the date and time of [START] and [END] when narrowing the search range.

5. Click [SET].
   The first image of the search range is displayed as a still image in the PREVIEW screen.
   If a motion detection search is not performed, click the PREVIEW screen as is. Change to main screen and playback images.

6. Set the detection points for motion.
   (MOTION SENSOR SET)
   The setting frame of the motion detection point will display in the PREVIEW screen as an 8 (vertical) x 10 (horizontal) square.
   If you click over the square, a red mark will display and be set to a motion detection point. If you click again, the setting will be cleared. Set a motion detection point to the required portion while viewing the PREVIEW screen.

7. Set [MOTION SENSOR LEVEL].
   Set the detection sensitivity of the motion sensor.
   Selected value: OFF/1 (high) to 10 (low)
   Increase the set value if you want to avoid detection of small vibrations or movements of the object due to factors such as wind.

8. Click [PREVIEW].
   Execute a motion detection search for images within a specified search range.
   When an image with movement is detected, it will display as a still image in the PREVIEW screen.
   When multiple images with movement are detected, the detected images will display in order from the oldest each time [PREVIEW] is clicked.

9. Click PREVIEW screen.
   Change to main screen and playback images. You can perform normal playback operations after playback starts.

- Message box display
  Each time search conditions are set or when the [SET] or [PREVIEW] buttons are clicked,
  the search status and results will display in a message box over the PREVIEW screen.

- Display message:
  - SEARCHING
  - FOUND
  - IMAGES NOT FOUND!
Saving Images

This software offers three image storage methods. Select the storage method according to your purpose.

- Saving live video on the computer
- Copying recorded images to the DVR's archive area (Refer to P18)
- Downloading recorded images to the computer (Refer to P19)

- Full screen must be used when saving images. Images cannot be saved when using the quad-screen or the multi-screen.
- Use the included playback application software “DVR Viewer2” to playback image files saved on the computer. (Refer to P36)
- If the network is diagnosed busy due to environment, it may get disconnected to protect the DVR’s recording operations. In this case, reduce and adjust the number of images being recorded.

A Saving live video on the computer
Images are not saved on the DVR when using this method.

1 Display the live video and click the channel select button.
The full screen is displayed and the save setting menu appears.

2 Setting up the image display mode.
   - READ INTERVAL:
     Setting a higher the value will result in a higher number of images being saved within a certain period.
   - SIZE and QUALITY:
     This does not affect the saved images.
   - AUDIO:
     Set audio to “ON” to save audio, as well as images.

3 Set [SAVE TO PC] to “ON” and click [SET].
The save setting menu is displayed at the bottom of the screen.

4 Set [DURATION].
   Set the duration of saving image.
   Units: Hour(s)/Minute(s)

5 Click [BROWSE], select the destination folder among the list of folders and click [OK].
The destination folder appears in [DESTINATION FOLDER].
The destination folder may be directly entered in [DESTINATION FOLDER].

6 Click [START].
The computer starts saving and the operation status is displayed.

7 At the end of the image save operation, the image freezes and the “SAVE COMPLETE” dialog appears.
   Clicking [OK] will result in returning to live video.

Elaboration:

- Setting menu for saving

1 Elapsed time
2 Image saving duration
3 Destination folder
4 Save in progress message
5 [CANCEL] button:
   Clicking the button will cancel save operations.

- Full screen must be used when saving images. Images cannot be saved when using the quad-screen or the multi-screen.
- Use the included playback application software “DVR Viewer2” to playback image files saved on the computer. (Refer to P36)
- If the network is diagnosed busy due to environment, it may get disconnected to protect the DVR’s recording operations. In this case, reduce and adjust the number of images being recorded.
Copying Recorded Images to the DVR’s Archive Area

Copying the images that are recorded in the normal recording area and the alarm recording area to the DVR’s archive area.

If the [OVERWRITE] setting is set to "ON", the DVR will overwrite the previously recorded images sequentially once the recording area is full. We recommend you store important images in the archive area.

1. Play back the images you want to copy and click the channel selection button.
   The full screen appears, you can start copying.
   
   Use the search function to browse the recorded images you want to play. (Refer to P14)

2. Click to freeze the images at the point where you want to start copying.

3. Click in the operation panel.
   The COPY screen is displayed.

4. Choose the [UNIT] of the images to be copied.
   The images to be copied can be specified by the number of images or the duration.
   - **PICTURES:**
     Number of images from the starting point (Total number of images from the channel to be copied)
   - **TIME:**
     Duration from the starting point (recording time)

5. Specify the range of the images to be copied.
   Specify the value for the [UNIT] you chose in step 4.
   - **PICTURES:** Between 1 and 40,000
   - **TIME:** Hour(s): Minute(s): Second(s) (00:00:01 - 99:59:59)

6. Check the box of the channel to be copied.
   The box of the channel being currently displayed is automatically checked. The check cannot be removed.
   - **ALL:** Checks all the channels.
   - **RESET:** Uncheck the channels except for the channel being currently displayed.

7. Click **START**.
   Copying operation starts.
   Once the copying operation is complete, the result of the copy is displayed.

   To interrupt the copying operation, click **CANCEL**. The copying operation that was performed until the interruption is valid, therefore the images up to that point are saved in the archive area of the DVR.

8. Click **LIVE**.
   The operation returns to live video.

   - Copy operations cannot be performed while playing back images stored in the archive area.
   - Only image data can be copied in the archive area. If images contain audio data, only image data is copied.
   - If the archive area becomes full during the recording operation, the copying operation will automatically be interrupted.

   Once the necessary images among the images saved in the archive area have been downloaded to such media as a CompactFlash, click the [AREA FULL RESET] button under the RECORDING AREA SET and copying operation restarts. (Refer to P25)
Saving Images

Downloading Recorded Images to the Computer

Downloading DVR recorded images to the drive of a networked computer.

1. Playback the images you want to download and click the channel selection button. The full screen is displayed, you can start downloading. Use the search function to browse the recorded images you want to play. (Refer to P14)

2. Click to freeze the images at the point where you want to start downloading.

3. Click in the operation panel. The DOWNLOAD screen is displayed.

4. Select the [UNIT] of the images you want to download. You can specify the images you want to download using the number of images or the duration.
   - **PICTURES**: Number of images from the starting point (Total number of images from the channel to be downloaded)
   - **TIME**: Duration from the starting point (recording time)

5. Set [AUDIO]. To download audio data, as well as the image data, select “ON”.

6. Setting up the range of the images you want to download. Specify the value for the [UNIT] you chose in step 4.
   - **PICTURES**: Between 1 and 40,000
   - **TIME**: Hour(s): Minute(s): Second(s) (00:00:01 - 99:59:59)

7. Check the box of the channel you want to download from. The channel currently displayed is automatically checked. The check mark cannot be removed.
   - **ALL**: Checks all the channels.
   - **RESET**: Uncheck the channels except for the channel being currently displayed.

8. Click BROWSE, select the destination folder among the list of folders and click [OK]. The destination folder appears in [DESTINATION FOLDER]. The destination folder may be directly entered in [DESTINATION FOLDER].

9. Click START. Downloading starts and the operation status is displayed.

10. Click once the “DOWNLOAD FINISHED!” dialog appears. The result of the download is displayed.

11. Click LIVE. The operation returns to live video.

Use the search function to browse the recorded images you want to play. (Refer to P14)
Saving Images

Saving Format for Image Files
The format (structure) of files downloaded to the computer using the “SAVE TO PC” or “DOWNLOAD” operations is as follows.

The data is saved in a 3 layer structure in the specified destination folder.

- In the 1st layer a “DVR + a five digit sequence number” appears. It contains the image data of one download.
- The image data is placed in the 2nd layer in 200 picture subfolders under the IMG folder. Up to 40,000 images can be downloaded at one time.
- If there is audio attached to the images, it is saved as a .WAV file in the “SOUND.WAV” folder.
- The “INFO” folder is created in download units and the setting information file is saved.

⚠️ The “INFO” folder is only created when “DOWNLOAD” operations are used to save files.
Operating a Dome Camera

(User level: ID2/3)

When connecting a coaxial superimposed dome camera, you can operate the camera by remote control using the computer. To do that, change the operation panel to the camera control panel.

- The camera control function is only available on 9/16-channel models.
- When switching from the operation panel to the camera control panel, display live video on full screen. You cannot switch to the camera control panel while using the quad-screen or the multi-screen or while playing images back.
- The camera control cannot be operated while [AUDIO] or [SAVE TO PC] are set to "ON" or if the clock of the DVR has not been set.

1. Display the live video and click the channel select button.
   The full screen is displayed and the \text{CAMERA CONTROL} button appears.

2. Click \text{CAMERA CONTROL}.
   The operation panel switches to the camera control panel from which you can operate the camera.

3. Click \text{CAMERA CONTROL} once again.
   The camera control operating panel disappears and the normal operation panel is displayed again.

**Functions of the camera control operating panel**

1. \text{Channel selection button}
   Click the channel that will control the camera.
   The layout of the buttons varies according to the DVR model.
   - 16-channel model: 1\text{1} - 1\text{6}
   - 9-channel model: 1\text{0} - 1\text{2}

2. \text{Channel display box}
   The selected channel number is displayed.

3. \text{Pan/Tilt button}
   Click these buttons to change the angle of the lens in eight directions down, left, right and diagonally.

4. \text{Speed}
   The operating speed of the camera can be adjusted to seven speeds.

5. \text{ZOOM/FOCUS/IRIS switch buttons}
   Click to adjust the zoom, focus or iris.
   (The selected button turns green.)

6. \text{ZOOM/FOCUS/IRIS adjustment button (+/-)}
   - ZOOM: + (Zoom In), - (Zoom Out)
   - FOCUS: + (Far), - (Near)
   - IRIS: + (Open), - (Close)

7. \text{Auto focus button (AF)}

8. \text{SEQ/PAN/TOUR switch buttons}
   Click to switch between sequence, auto-pan and tour.

9. \text{Preset buttons}
   Click to change the angle of the camera to the position recorded in the preset number.
   To select a preset number higher than "09" (09 - 64), use the pull down menu and click.

10. \text{Presetting a position}
    To preset a position, choose a preset number using the pull down menu and click.
    The preset position is recorded.

11. \text{Recording operation buttons}
    - : Starts a manual recording.
    - : Stops a manual recording.
    - : Switches to timer recording functions.

12. \text{Disconnect button}
    Disconnects the connection with the DVR and changes from network operation to DVR operation.

The included example uses the 16-channel model.
Setting up the Basic Menu Using Network Operations

The DVR operating condition is usually set through the DVR. However, the following basic operation menu allows you to set the DVR using the computer.

### Basic Settings Menu Outline

#### Initial setting
- **A** CLOCK SET (Refer to P24)
  Setting the DVR's clock
- **B** SUMMER TIME SET/EXT. CLOCK SET (Refer to P24)
  To set the automatic summer time change and the automatic setting of the connected DVR clock.
- **C** HOLIDAY SET (Refer to P24)
  To set dates that will be considered as holidays.

#### Recording settings
- **A** RECORDING AREA SET (Refer to P25)
  To display the proportion of each recording area and set the recording resume operation when recording was stopped due to the recording exceeding the area capacity.
- **B** RECORDING CONDITIONS SET (Refer to P26)
  To choose overwriting and other hard disk related condition settings.
- **C** NORMAL REC MODE SET (Refer to P27)
  Normal and timer-controlled recording condition settings.
- **D** PROGRAM REC SET (Refer to P28)
  To program the individual or the combined recording rate of the recording cameras
- **E** TIMER SET (Refer to P28)
  Timer-controlled recording condition settings.
- **F** ALARM REC MODE SET (Refer to P30)
  Alarm recording and pre-alarm recording condition settings

#### General settings
- **A** DISPLAY SET (Refer to P32)
  To set the information display for the connected monitors.
- **B** BUZZER SET (Refer to P32)
  Warning buzzer settings
- **C** HDD SET (Refer to P33)
  To set HDD information display and specify the playback disk when 2 HDD units are connected.
- **D** NETWORK SET (Refer to P34)
  To set the network connection conditions and the connection password.
- **E** RS-485 SET (Refer to P34)
  DVR interface information display when operating the system controller

#### Screen settings and DVR information
- **A** MASK SET (Refer to P35)
  Mask settings for specific channels
- **B** POWER LOSS/USED TIME (Refer to P35)
  Power loss history, operating time, firmware version, etc. information display
- **C** INITIALIZATION LOG (Refer to P35)
  Hard disk initialization history information display

The setting menus outside the ones above are outside the scope of network operations. Therefore, use the DVR to set any other settings.
Setting up the Basic Menu Using Network Operations

Basic menu setting procedure

1. Click ![Menu button](image) in the operation panel. The MAIN MENU screen is displayed. The screen cannot be switched to the MAIN MENU screen while playing back images.

2. Select the menu and click. The selected menu screen is displayed. If it is connected to the DVR for the first time, verify that the date and time on the DVR are set correctly using the CLOCK SET screen.

3. Setting the contents of each menu. The current setting information of the DVR is loaded and displayed on the screen. Confirm the settings and change the settings if necessary.

   ![CLOCK SET example screen](image)

   ![NORMAL REC MODE SET example screen](image)

4. Click ![SET](image) or ![SAVE](image) once the setting is complete. The settings are determined and uploaded to the DVR.

   - Settings can be loaded but not changed while the DVR is recording.

   - The menu screens limited to information display function do not have a [SET] or [SAVE] button.

5. Click ![Menu button](image) in the operation panel. The live video on the main screen is displayed again. To set settings from several menu screens

   To switch from one menu screen to another click ![Menu button](image) Once the MAIN MENU screen is displayed, repeat the above procedure to choose new settings.
Initial setting

(A User level: ID3)

**A | CLOCK SET**

Setting the internal clock of the DVR.
Set the day/month/year/hour/minute using the pull down menu. The day is automatically set according to the date.

If the clock if not set on the DVR, recording and camera control operations are not possible.

**B | SUMMER TIME SET/EXT. CLOCK SET**

Setting the automatic summer time change and the adjust function of the clock of the connected DVR.

1. **SUMMER TIME SET (Initial setting: USE)**
   Set the automatic summer time change function if the DVR is used in a daylight saving area.
   - **USE:** Setting the automatic summer time change function.
     - Set the summer time start (ON) and end (OFF) date using [WEEK], [MONTH], [TIME].
   - **NO USE:** Not setting the automatic summer time function.

2. **EXT. CLOCK SET (ADJUST TIME)**
   It automatically adjusts the time of each DVR if more than 2 DVRs are connected. Select the time at which all the clocks will be adjusted using the pull down menu.
   A signal is output to the clocks of the DVRs connected to the [CLOCK OUT] terminal situated at the rear of the DVR, everyday at the specified time, and their time adjusted to the second.

**C | HOLIDAY SET**

Dates set as national holidays, anniversaries, etc are considered as holidays and timer recording operations will be the same as for Sundays.
Set the holiday dates using the pull down menu. Up to 20 dates can be set.
Recording settings

A  RECORDING AREA SET

The proportion of each recording area on the internal HDD is displayed. Recording operations will stop once the recording area is full. However, recording operations can be resumed by clicking the [AREA FULL RESET] button.

Recording area capacity display

The capacity of each recording area (proportion) specified using the RECORDING AREA SET function of the DVR is displayed. This cannot be changed using the computer.

Images are recorded (saved) on each recording area according to the recording method chosen.

<table>
<thead>
<tr>
<th>Recording area</th>
<th>Recording method</th>
</tr>
</thead>
<tbody>
<tr>
<td>NORMAL RECORDING AREA</td>
<td>Normal recording</td>
</tr>
<tr>
<td></td>
<td>(manual recording)</td>
</tr>
<tr>
<td></td>
<td>Timer recording</td>
</tr>
<tr>
<td>ALARM RECORDING AREA</td>
<td>Alarm recording</td>
</tr>
<tr>
<td></td>
<td>Pre-alarm recording</td>
</tr>
<tr>
<td>ARCHIVE AREA</td>
<td>Copy (Save)</td>
</tr>
</tbody>
</table>

Setting [MIRRORING] to "ON" in the HDD SET of the DVR will display the disk capacity of the disk with the lowest capacity.

[AREA FULL RESET] button

This button is displayed depending on the settings of [OVERWRITE] in RECORDING CONDITIONS SET. Recording operations will stop once the space available on each recording area is insufficient. To resume the recording operations using overwrite, click [OVERWRITE]. This operation is called [AREA FULL RESET].

- Normal/Alarm recording area settings
  The button is only displayed if [OVERWRITE] is set to "OFF".
- Archive area settings
  Buttons that are always displayed.

- If [OVERWRITE] is set to "ON" for the normal recording and the alarm recording area, or if the normal recording area or alarm recording area is set to "0%" the [AREA FULL RESET] button is not displayed.
- Resuming the recording operations using the [AREA FULL RESET] button, will only overwrite the data once. Full disk will result in the interruption of recording operations.
- To lock the DVR to overwrite mode set [OVERWRITE] to "ON".
- The [AREA FULL RESET] is not available if there is still space available on each recording area.
Recording settings

**B | RECORDING CONDITIONS SET**

It allows you to set HDD recording area management conditions such as overwrite recording, remaining disk warning level, automatic erase function, etc.

**OVERWRITE (Initial setting: ON)**

Setting recording conditions to overwrite for the normal and alarm recording areas.

**ON:**

When the hard disk becomes full, recording continues and data is automatically overwritten from the first images.

The [AREA FULL RESET] button of the normal or alarm recording area does not appear on the RECORDING AREA SET screen.

**OFF:**

The remaining capacity warning indicator of the DVR starts blinking when the recording area becomes full, recording stops.

**AUTO DELETE (Initial setting: OFF)**

It is the automatic erase function of the images saved in the normal and alarm recording area. The image data that is older than the specified storage period are automatically erased.

**SERIES REC (Initial setting: OFF)**

Series recording can be set if the multiple DVR units are connected using the SERIES REC terminal at the rear panels.

Series recording implies that recording can automatically continue on the next DVR unit when the recording area of the first DVR becomes full.

**ON:** Performing series recording.

**OFF:** Series recording is not activated.

Series recording is only available when [OVERWRITE] is set to "OFF".

**REMAINING DISK WARNING**

The remaining disk warning buzzer can be programed to go off when the remaining space available reaches a specified value if the [OVERWRITE] setting is set to "OFF" for the normal and alarm recording area.

Now, setting the remaining disk warning level that will set the warning buzzer on. The set level will apply to both the normal and alarm recording areas.

**AUTO DELETE (Initial setting: OFF)**

It is the automatic erase function of the images saved in the normal and alarm recording area. The image data that is older than the specified storage period are automatically erased.

**Selections:** OFF, 1, 2, 3 ... 99 DAYS

**1 - 99 DAYS:** To set the auto delete function and storage period between 1 and 99 days.

**OFF:** The images will not be erased automatically.

- The auto delete function does not apply to the archive area.
- If you use the auto delete function, copy or download important data before the storage period expires. (Refer to P18, 19)

**WARNING**

When the [OVERWRITE] setting of the normal and alarm recording area is set to "ON", "***" is displayed, the remaining disk warning level cannot be set.
Recording settings

C | NORMAL REC MODE SET

It allows you to set the recording conditions of the normal recording and timer-controlled recording of the DVR.

The quality of the image depends on “image quality x recording rate”. The higher frequency recording rate of the image, the higher the quality of the image. However, the amount of disk space needed to record these images is proportional to the quality of the image. Therefore, selecting a more quality image will result in shortened recording time.

1 PICTURE QUALITY (Initial setting: ENHANCED)
It allows you to set the quality of the image recorded by the DVR.

Selecting a high quality image will result in shortened recording time.

Selections:
- BASIC: Basic image quality
- NORMAL: Normal image quality
- ENHANCED: Enhanced image quality
- FINE: Fine image quality
- SUPER FINE: Super fine image quality

2 AUDIO RECORDING (Initial setting: OFF)
Simultaneous audio recording is possible for normal and timer-controlled recording.

ON: Simultaneous audio recording on
OFF: Audio recording off

Audio data is recorded in the same recording area as the images. Therefore, recording time is shortened.
- If recording audio, set the recording rate between "1 - 50 FPS".

3 REC RATE (Initial setting: 12.5 FPS)
To set the recording rate for normal recording.

The letter “A” is displayed in front of the available recording rate.

Available settings:
50, 25, 16.67, 12.5, 8.333, 6.25, 5, 4.167, 3.571, 3.125, 2.778, 2.5, 2.273, 1.923, 1.667, 1.471, 1.316, 1.19, 1.087, 1, 0.5, 0.333, 0.25, 0.2, 0.1, 0.05, 0.033 (Unit: FPS)

About the Recording Rate
- If multiple cameras are connected to the DVR, the recording rate of each channel varies according to the number of cameras connected.
- If you use PROGRAM REC SET to program the recording rate of each individual camera, the recording rate cannot be set using NORMAL REC MODE SET.
- Recording rates available are limited when pre-alarm recording or mirroring is set to “ON”. Refer to the DVR manual for more information.
- Use the TIMER SET to program the recording rate when using timer recording. (Refer to P28)

4 REC PROGRAM GROUP (Initial setting: OFF)
Recording conditions preset using PROGRAM REC SET (program number) can be selected. (Refer to P28)

Selections: OFF, P-1, P-2, P-3, P-4

OFF: Programed recording is not used.
- A common recording rate for all the connected cameras is set using [REC RATE] on this screen.

P-1 - P-4:
- The DVR records the images at the rate programed for each camera.

5 Recording duration
Clicking [SAVE], displays, for your reference, a rough recording duration estimate according to the set recording rate.
Recording settings

If multiple cameras are connected to the DVR, the recording rate of each camera can be set individually. 4 recording settings can be preset (P-1 - P-4). Pre-programmed settings can be used for NORMAL REC MODE SET and TIMER SET.

1 PROGRAM
Specify a program number and set the recording rate for an individual camera using 2. Different recording rates can be set for each program.

Selections: P-1, P-2, P-3, P-4

2 SELECT INDIVIDUAL CAMERA RATE (FPS)
Select the recording rate for an individual camera. By setting the rate of an individual camera to "OFF", no images are recorded even if a camera is connected.

Available settings:
OFF, 25, 12.5, 6.25, 3.125, 1.563, 1, 0.5, 0.333, 0.25, 0.2, 0.1, 0.05, 0.033 (Unit: FPS)

3 [SAVE] button
Clicking [SAVE] will save the settings of the selected program.

4 NORMAL REC
Once the program has been saved the estimated normal recording time is displayed.

- The menu screen may vary according to the DVR model.
- Recording rates available are limited when pre-alarm recording or mirroring is set to "ON". Refer to the DVR manual for more information.

It allows you to set the recording conditions for timer recording.

1 WEEK
To set the day for the timer-controlled recording.
To set the timer recording to the same time every day set to "DLY".

2 START/STOP
Set the timer recording start and stop time.

3 PROGRAM (Initial setting: OFF)
You can select a program that has been preset (P-1 - P-4) using PROGRAM REC SET.

4 FPS (Initial setting: 12.5 FPS)
To set the recording rate of the timer recording. If the rate was set using [PROGRAM], the preset recording rate will be used.

5 SET (Initial setting: OFF)
Select "ON" to enable the settings programmed in this row. The timer recording will start and stop accordingly. Multiple timer controlled recording periods may be used to divide recording times according to the conditions set.

6 EXT
If using an external timer set 3, 4 and 5. The recording will occur according to the incoming signal of the external timer. There is no need to set the day or start and stop time.

7 [OVER 24H] button
When recording continuously for a period of over 24 hours using the timer recording, click this button to display the appropriate program screen.

8 [SAVE] button
Clicking [SAVE] will save the timer settings.
Example of timer-controlled recording

Set the timer-controlled recording conditions based on the following example.
To operate the timer recording click in the operation panel.
The following message is displayed in the operating mode display panel when timer controlled recording is on.
- Standby: TIMER STANDBY
- Timer recording: TIMER RECORDING

Example: Setting the timer to every Sunday from 7:30 to 18:00, recording rate of 25 FPS

1 Setting the timer-controlled recording conditions.
   ① Set [WEEK] to “SUN”
   ② Set [START] to “7:30” and [STOP] to “18:00”
   ③ Set [PROGRAM] to “OFF”
   ④ Set [FPS] to “A 25 FPS”
   ⑤ Set [SET] to “ON”
   Set other timer-controlled recording conditions through the same procedure. You can set up to eight timer recordings.

2 Click .
The timer setting is complete.

Example: Recording every day from 10:00 to 20:00 using the “P-1” recording pattern.

1 Setting the timer-controlled recording conditions.
   ① Set [WEEK] to “DL Y”
   ② Set [START] to “10:00” and [STOP] to “20:00”
   ③ Set [PROGRAM] to “P-1”
   ④ Set [SET] to “ON”
   ⑤ In the first row, set the day and time start of the recording.
      ① Set [WEEK] to “SAT”.
      ② Set [START] to “16:00”.
   ⑥ In the second row, set the day and time at which the recording will stop and the recording conditions.
      ③ Set [STOP] to “22:00”.
      ④ Set [PROGRAM] to “OFF”
      ⑤ Set [FPS] to “A 25 FPS”
      ⑥ Set [SET] to “ON”

2 Click .
The over 24 hours timer recording is set.

Example: Setting the timer to record 30 hours every Saturday from 16:00 to 22:00 the next day, recording rate of 25 FPS

1 Click [OVER 24H].
   The last two rows (rows 7 and 8) used for over 24 hours timer recording are displayed.
   ① In the first row, set the day and time start of the recording.
      ① Set [WEEK] to “SAT”.
      ② Set [START] to “16:00”.
   ⑥ In the second row, set the day and time at which the recording will stop and the recording conditions.
      ③ Set [STOP] to “22:00”.
      ④ Set [PROGRAM] to “OFF”
      ⑤ Set [FPS] to “A 25 FPS”
      ⑥ Set [SET] to “ON”

2 Click .
The over 24 hours timer recording is set.

Recording at the same time every day using timer recording

Example: Recording every day from 10:00 to 20:00 using the “P-1” recording pattern.

1 Setting the timer-controlled recording conditions.
   ① Set [WEEK] to “DL Y”
   ② Set [START] to “10:00” and [STOP] to “20:00”
   ③ Set [PROGRAM] to “P-1”
   ④ Set [SET] to “ON”

2 Click .
The setting of the timer recording conditions is complete.

Setting the timer for continuous recording lasting more than 24 hours

Example: Setting the timer to record 30 hours every Saturday from 16:00 to 22:00 the next day, recording rate of 25 FPS

1 Click [OVER 24H].
   The last two rows (rows 7 and 8) used for over 24 hours timer recording are displayed.
   ① In the first row, set the day and time start of the recording.
      ① Set [WEEK] to “SAT”.
      ② Set [START] to “16:00”.
   ⑥ In the second row, set the day and time at which the recording will stop and the recording conditions.
      ③ Set [STOP] to “22:00”.
      ④ Set [PROGRAM] to “OFF”
      ⑤ Set [FPS] to “A 25 FPS”
      ⑥ Set [SET] to “ON”

2 Click .
The over 24 hours timer recording is set.

If timer recordings overlap.
Priority is given as follows “Day timer → Daily timer → External timer”.
If the both the day timer and the daily timer overlap, the timer will start recording according to the program that starts earliest. If the start time is the same, the recording will be prioritized starting from the upper row.
It allows you to set the alarm recording and the pre-alarm recording conditions.

1. **ALARM RECORDING** (Initial setting: OFF)
   To set the alarm recording operation mode.
   
   **Selections:**
   - OFF: No alarm recording.
   - ENABLED: Enables alarm recording at any given point in time regardless of timer recording.
   - AL-REC ON TIMER: Records alarm recording only during timer controlled recording operation.
   - AL-REC OFF TIMER: Records alarm recording outside timer controlled recording operations.
   - OLY AL-REC ON TIMER: Records alarm recording only during the time slot set for the timer controlled recording.
   (Even if a timer controlled recording is set, the standby mode of the timer controlled recording is not activated.)

2. **PICTURE QUALITY** (Initial setting: ENHANCED)
   It allows you to set the quality of the image recorded by the DVR.
   Selecting a high quality image will result in shortened recording time.
   
   **Selections:**
   - BASIC (Basic image quality)
   - NORMAL (Standard image quality)
   - ENHANCED (Enhanced image quality)
   - FINE (Fine image quality)
   - SUPER FINE (Super fine image quality)

3. **AUDIO RECORDING** (Initial setting: OFF)
   Audio data can be recorded at the same time as image data.
   
   **ON:** Audio recording on.
   **OFF:** Audio recording off.
   
   - Audio data is recorded in the same recording area as the images. Therefore, recording time is shortened.
   - If recording audio, set the recording rate between “1 - 25 FPS”.

4. **ALARM INTERLEAVE** (Initial setting: ONLY)
   Setting the recording pattern when multiple cameras are connected to the DVR.
   
   **Selections:**
   - ONLY: Records only the images of the camera that detected the alarm.
   - SW: Records the images of the camera that detected the alarm and the images of the other cameras alternately.
   The 6-channel model will record images as follows when the alarm is triggered by CH1:
   CH1 → CH2 → CH1 → CH3 → CH1 → CH4 → CH1 → CH5 → CH1 → CH6

5. **REC RATE** (Initial setting: 12.5 FPS)
   To set the recording rate of the alarm recording.
   The letter “A” is displayed in front of the available recording rate when AUDIO RECORDING is set to “ON”.
   
   **Available settings:**
   25, 16.67, 12.5, 8.333, 6.25, 5, 4.167, 3.571, 3.125, 2.778, 2.5, 2.273, 1.923, 1.667, 1.471, 1.316, 1.19, 1.087, 1, 0.5, 0.333, 0.25, 0.2, 0.1, 0.05, 0.033 (Unit: FPS)

6. **DURATION** (Initial setting: 20 SEC)
   It allows you to set the duration of the recording once the alarm has been triggered.
   
   **Available settings:**
   5, 10, 20, 30 SEC, 1, 2, 3, 4, 5, 10, 15 MIN, CC
   - CC: Records only when an alarm is detected. One alarm will start a recording of at least 5 seconds.
Recording settings

5 PRE-ALARM RECORDING
Allows you to set the pre-alarm recording operation mode.

ON: Activates pre-alarm recording.
OFF: Pre-alarm recording is not activated.

If the alarm recording operation mode is set to "OFF", "***" is displayed and pre-alarm recording cannot be set.

A REC RATE (Initial setting: 12.5 FPS)
It allows you to set the pre-alarm recording rate.

Available settings:
25, 16.67, 12.5, 8.333, 6.25, 5, 4.167, 3.571, 3.125, 2.778, 2.5, 2.273, 1.923, 1.667, 1.471, 1.316, 1.19, 1.087, 1
(Unit: FPS)

B DURATION (Initial setting: 1 MIN)
To set the duration of the pre-alarm recording.

Available settings:
3, 5, 10, 20, 40 SEC, 1, 2, 3, 4, 5, 10, 15 MIN

6 ALARM TRIGGER (Initial setting: ALARM)
It allows you to set under what conditions the alarm recording is triggered.

Selections:
ALARM (External alarm):
When an alarm signal is input to the alarm input terminal at the rear of the DVR
SENSOR (Motion sensor):
When the motion sensor detects movement
ALARM AND SENSOR:
When both the external alarm and the motion sensor are triggered at the same time
ALARM OR SENSOR:
When either the external alarm or the motion sensor is triggered

7 Number of alarm recordings
Clicking [SAVE], displays, for your reference, the number of alarm recordings that can be recorded according to the set conditions.
## General settings

### A DISPLAY SET

It allows you to select what is displayed on the monitor that is connected to the DVR. It is not related to the main screen of the computer.

<table>
<thead>
<tr>
<th>Display Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATE (Initial setting: ON)</td>
<td>To display the current date of the live video or the date of recording of the images being played back.</td>
</tr>
<tr>
<td>TIME (Initial setting: ON)</td>
<td>To display the current time of the live video or the time of recording of the images being played back.</td>
</tr>
<tr>
<td>QUALITY (Initial setting: ON)</td>
<td>To display the image quality of the current recording or of the recording being played.</td>
</tr>
<tr>
<td>AUDIO (Initial setting: ON)</td>
<td>When the [AUDIO RECORDING] is set to &quot;ON&quot;, the letter &quot;A&quot; is displayed.</td>
</tr>
<tr>
<td>ALARM COUNT (Initial setting: ON)</td>
<td>To display the alarm count. Once the alarm count reaches 9999, it is reset to 0 and starts again.</td>
</tr>
<tr>
<td>ALARM TYPE (Initial setting: ON)</td>
<td>Alarm recordings are displayed as &quot;ALARM&quot; and pre-alarm recording as &quot;PRE&quot;.</td>
</tr>
<tr>
<td>TITLE (Initial setting: ON)</td>
<td>To display the title of the camera.</td>
</tr>
</tbody>
</table>

![Display on the DVR monitor](image)

### B BUZZER SET

It allows you to choose to activate the warning buzzer of the DVR for the remaining disk warning, the alarm, etc. Set to "ON" to sound the warning buzzer. Usually, the warning buzzer cannot be controlled using the computer. However, if an audio file is saved on the computer you can choose to trigger the warning buzzer only at the time when the alarm is triggered. (Refer to P33)

<table>
<thead>
<tr>
<th>Buzzer Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALARM (Initial setting: OFF)</td>
<td>Activates the buzzer when the alarm is triggered.</td>
</tr>
<tr>
<td>DISK FULL (Initial setting: ON)</td>
<td>Activates the buzzer when the remaining capacity on each recording area has decreased to the set remaining capacity warning. (Refer to P26)</td>
</tr>
<tr>
<td>DISK ERROR (Initial setting: ON)</td>
<td>Activates the buzzer when there is a disk error.</td>
</tr>
<tr>
<td>LOCK WARNING (Initial setting: ON)</td>
<td>Activates the buzzer when a button of the operation panel that has not been authorized is pressed.</td>
</tr>
<tr>
<td>KEY IN (Initial setting: OFF)</td>
<td>Activates the buzzer when an operation button on the front panel of the DVR is pressed.</td>
</tr>
<tr>
<td>NON REC (Initial setting: OFF)</td>
<td>Activates the buzzer when a recording is interrupted during a recording operation.</td>
</tr>
</tbody>
</table>

![Buzzer Set](image)
Setting the buzzer using the computer

A Activating the buzzer using the computer when the alarm is triggered

1 Create a "BUZZER" folder in the root directory of the C drive.

2 Store the buzzer audio file in .WAV format under "BUZZER.WAV" in the folder.
   Example: C:\BUZZER\BUZZER.WAV
   The above settings result in the computer activating the audio file when the alarm is triggered.
   • The buzzer is activated approximately one second into the sound file. Create a valid audio file so that it will start during that period.
   • Do not use a large sound file.
   • The computer buzzer is only activated when the alarm is triggered.

B Stopping the computer buzzer

Click (playback/stop button) of the operation panel.
   • Regardless of the computer buzzer settings, when an alarm is triggered, clicking on the playback/stop button will stop the buzzer.
   • If the alarm is triggered while playing back data, click the playback/stop button twice to deactivate it.

C Deactivating the computer buzzer

Erase the created folder or the sound file or change the sound file name or file location.

C HDD SET

Displays the HDD information of the DVR unit.
Specifies the disk used to play back mirroring recordings.

<table>
<thead>
<tr>
<th>HDD SET</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISK 1</td>
</tr>
<tr>
<td>DISK 2</td>
</tr>
<tr>
<td>MIRRORING</td>
</tr>
<tr>
<td>PLAYBACK DRIVE</td>
</tr>
</tbody>
</table>

• DISK 1/DISK 2 (HDD Capacity)
Displays the total capacity of the HDD mounted on the DVR. When two HDD units are mounted on the DVR, it shows the individual capacity of each disk.

• MIRRORING
Displays the mirroring recording settings of the DVR.

What is mirroring?
Mirroring is when multiple HDD units are used and the same image is recorded on 2 HDD units at the same time. Mirroring allows you to read normal images from a second disk in the unlikely event that the images cannot be read from the first disk.

• PLAYBACK DRIVE
It allows you to select the playback drive when multiple HDD units are used and mirroring recording is to “ON”.

Selections: DISK 1/DISK 2

The [PLAYBACK DRIVE] pull down menu is not displayed when using a single HDD or if mirroring recording is set to “OFF”.

General settings

D | NETWORK SET

The NETWORK SET allows you to set the network before the DVR is connected to it. The menu on this screen enables you to change DVR settings through the computer.

After changing the network settings, switch to the DVR operations. Reconnect the DVR with the network.

1 IP ADDRESS / SUBNET MASK / GATEWAY
   Input values between “0 - 255”

2 PORT
   Normally set to “80”.

To choose a PORT setting other than the preset “80” add “: (colon)” after the IP address and the PORT number.

Example when setting PORT to 81
   http://192.168.0.1:81/

3 PASSWORD SETTING
   It allows you to set a confirmation password according to each user level. Type a password in each appropriate box. Choose a 4 to 8 alphanumeric character password.

<table>
<thead>
<tr>
<th>User level</th>
<th>ID1</th>
<th>ID2</th>
<th>ID3</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>ID1</td>
<td>ID2</td>
<td>ID3</td>
</tr>
<tr>
<td>Operations allowed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Live video monitoring</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Playback</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Camera control</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Recording</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVR settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Password (initial setting)</td>
<td>1111</td>
<td>2222</td>
<td>3333</td>
</tr>
</tbody>
</table>

4 NETWORK SPEED (Initial setting: NO LIMIT)
   It allows you to set the network transmission speed.

Available settings:
   NO LIMIT, 64, 128, 256, 512, 1024Kbps

Restarting or resetting the DVR will restore initial setting (NO LIMIT).

E | RS-485 SET

Displays the interface information set through the DVR when using the system controller operations.

<table>
<thead>
<tr>
<th>1 DATA SPEED (Unit: bps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the data transmission speed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2 STATUS INFO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the state of the transmission of the status information.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3 ALARM INFO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the state of the transmission of the alarm information.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4 ADDRESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows the set address.</td>
</tr>
</tbody>
</table>
Screen settings and DVR information

(User level: ID3)

A  MASK SET

A grey pattern can be set on a specified channel used to watch live video or play back images to protect confidentiality and privacy.

1  MASK (Initial setting: OFF)
To choose mask settings. Choosing "ON" allows you to set a grey pattern on each of the channels of the main monitor, monitor 2 and network.

2  TIME PERIOD (Initial setting: T-1)
It allows you to set time periods.
Selections: T-1, T-2, T-3, T-4
The parentheses of "T-1 - T-4" show the time periods that were preset using TIME PERIOD SET of the DVR.

3  Setting the mask portion for each monitor (Initial setting: OFF)
You can set the grey pattern for each channel of each of these 3 monitors.
- MAIN MONITOR represents the screen of the main monitor connected to the DVR.
- MON. 2 represents the screen of the spot monitor connected to the DVR.
- NETWORK represents the main screen of the computer used for network operations.

NETWORK mask settings can only be programmed by ID1 users. ID2 and ID3 users can watch the images on all channels.

B  POWER LOSS/USED TIME

Displays the information concerning power loss/used time and firmware version information.

1  POWER
The number of power failure and the four most recent power failure records (Date and time of failure/recovery) are displayed.

2  USED TIME
The used time of each disk (DISK1 USE, DISK2 USE) and the total amount of electricity time (POWER) are displayed.

3  FIRMWARE
Displays the firmware version of the firmware currently mounted on the DVR.

C  INITIALIZATION LOG

The eight most recent occurrences among the initializing and recording restart records of the DVR’s hard disk are displayed.

1  DATE/TIME: Displays the date and time of the operation.
2  AREA: Displays the recording area for the operation.

The messages “INITIALIZED”, if the computer was initialized and “AREA RESET” if the recording area became full and recording was restarted, are displayed in parentheses next to the recording area.
DVR Viewer2

“DVR Viewer2” is a playback Viewer software. Use this software when playing audio data or images saved from the DVR on recording media such as HDD, CompactFlash, CD-R, etc. (The software is compatible with JPEG images and WAVE sound files.)

### Operating Environment

Environment to be used
- **CPU:** Pentium® IV (2 GHz) or higher
- **RAM:** 256 MB or more (512 MB or more recommended)
- **Compatible OS:** Windows 2000/XP
- **Compatible machines:** PC/AT machines operating with the above OS
- **Display:** Color (SVGA more than 65536 colors)
- **Available languages:** English or Japanese

### Installing the Viewer Software

Follow the procedure below to install the software before using it.

1. **Insert the included CD-ROM in the computer CD-ROM drive.**
   - Or, uncompress the downloaded “DVR Viewer2”.
   - You can download the most recent version of the software from our homepage.
   - Homepage address: http://www.sanyosecurity.com

2. **Double click the installer icon.**
   - The installer runs.

3. **Select the language to be used for install and the install destination following the instructions of the installer.**
   - The software starts installing.

4. **Click [Finish] once the install is complete.**
   - Once the “DVR Viewer2” is fully installed, a shortcut icon appears on the desktop.

When writing data from the DVR onto a CompactFlash card or a CD-R/RW, “DVR Viewer2” is copied to the save destination.

If an earlier version of Viewer software is installed on the computer, before installing the present software, uninstall the earlier version using [Add or Remove Programs] under the control panel.

### Internet Option Settings

Once the “DVR Viewer2” is fully installed, select Internet Explorer, [Tools] → [Internet Options] → [Security]. If you click the [Custom Level] in the [Security] setting screen, the [Security Settings] dialog pops up. Enable the “ActiveX controls plug-ins”.

### Running and Quitting Viewer

1. **Running DVR Viewer2.**
   - To run Viewer, double click the shortcut icon on the desktop or choose [Program] → [SANYO] → [DVR Viewer2] from the start menu.

2. **To quit Viewer.**
   - To quit Viewer, click [Exit] from the file menu or click the button situated in the top-right corner of the screen.

You can download the most recent version of the software from our homepage.

Homepage address: http://www.sanyosecurity.com
Structure of the Screen and the Function of each Section

Running the Viewer software will result in the initial screen of the Viewer being displayed.

1 Menu bar
   This is the basic menu of the Viewer software. Click each menu to display the breakdown of each command.
   1 File menu
      Open:
      The [Open] dialog is displayed.
      Save:
      To save playback still images.
      Print:
      To print playback still images.
      Title Input:
      To display the dialog that allows you to input the title of the print image.
      Exit:
      To quit the Viewer software.

2 Toolbar
   Frequently used command bars are deployed.
   1 To display the [Open] dialog.
   2 To save playback still images.
   3 To print playback still images.
   4 To switch the display pattern of the screen (1/4/9/16 screen).
   5 To display the version of the Viewer software.

3 Viewer screen
   The images of the loaded image files are displayed.
   Right clicking on the screen will display the context menu, which allows you to select the display pattern of the screen (1/4/9/16 screen) and the display channel.

4 Viewer operating panel
   It operates the playback of the images that are displayed on the Viewer screen. (Refer to P40)

1 File menu
   Open:
   The [Open] dialog is displayed.
   Save:
   To save playback still images.
   Print:
   To print playback still images.
   Title Input:
   To display the dialog that allows you to input the title of the print image.
   Exit:
   To quit the Viewer software.

2 View menu
   Toolbar:
   To show/hide the toolbar.
   Status bar:
   To show/hide the status bar.
   Camera Title:
   To show/hide the camera title.
   Date Display Format:
   To set the date display format. (Refer to P41)
   Time Display Position:
   You can position the date and time display (top-right/bottom-right/bottom-left/top-left) on the playback images.
   Image:
   To specify the display pattern of the screen (1/4/9/16 screen). (Refer to P39)

3 Help
   To display the version of the Viewer software.
Opening Image Files

The image files are not displayed when the Viewer Software is run. Specify and open the playback file through the procedure below.

1. **Click in the toolbar.**
   Or, click "Open" in the file menu.
   The [Open] dialog is displayed.

2. **Click .**
   The [Browse for Folder] dialog is displayed.

3. **Specify the folder in which the images are saved and click [OK].**
   The folder specified in the [Open] dialog is displayed.

4. **Verify the displayed folder and click [OK].**
   The image file loads.

5. **Screen display**
   The first image of the loaded file is initially displayed on full screen.

   Refer to the appropriate pages for details about the operations of the Viewer Screen.
   - Switching the display pattern (1/4/9/16 screen) of the playback images (Refer to P39)
   - Selecting the channels displayed on each screen (Refer to P39)
   - Operating panel functions (Refer to P40)
Switching the Display Pattern of the Screen

The image display pattern can be selected from 4 patterns: full screen, quad screen, 9 screen, 16 screen using the toolbar button.

Selecting the Channel Displayed on the Screen

Right clicking the Viewer screen will display the context menu. Clicking the channel you want to display within the context menu will switch the channel display.

When using the quad screen, the number of the channels being viewed is displayed in [Channel] of the operating panel.

Example: Displaying channel number 10 in the top right screen

- The display pattern can also be selected from the menu bar or from the context menu displayed on the screen.
- On the 4/8/16 screen, double clicking on a specific image will display it on full screen.
DVR Viewer2

Functions of the Viewer Operating Panel

The audio and image functions of the Viewer screen can be operated.

(Viewer Operating Panel)

1. Playback slide bar
   The time stamp (recording date and time) of the start and stop point of the playback file are displayed at both ends of the slide bar.
   Sliding the slide bar knob allows you to move the playback point.
   - Clicking the knob or sliding the knob while clicking it displays the number of the image of the video being displayed, on the cursor.
   - Clicking a position that differs from the current playback point using the slide bar will move the playback point by one percent of the total number of images.

2. Operating buttons
   Buttons that can be selected are black, buttons that are currently in function are green.
   - : Rewinds to the previous image when the image is on pause.
   - : Pauses the playback.
   - : Forwards to the next image when the image is on pause.
   - : If the slide bar knob is positioned to the right of the start point, the video can be played in reverse.
   - : If the slide bar knob is positioned to the left of the stop point, the video can be played in sequence.

3. Playback speed adjusting section (Initial setting: 3)
   Allows you to adjust the playback speed to 10 levels by sliding the slide bar knob.
   - Set the playback speed while playback is stopped.
   - When playing back audio, audio is played back at the rate at which it was recorded regardless of the [Playback Speed] set.

4. Audio adjusting section
   Allows you to turn on/off and adjust the volume of the audio playback when a playback file contains audio data.
   - Clicking the button turns the audio playback on and off.
   - Switch while the playback is stopped.
   - Sliding the knob allows you to adjust the audio volume to 10 levels.

5. Channel display
   The number of the playback channel of the images being displayed is shown on full screen and quad screen.

6. Time and date display
   The time stamp (recording date and time) of the images being viewed is displayed.

7. Image number display
   The number of the “current image and the total number of images” is displayed.
Saving and Printing Images

To save or print the image currently being displayed, switch to "Full screen display" and perform the following operations.

**Saving Images**

Click in the toolbar or "Save" in the File menu. The save dialog appears. Specify the destination folder and file and click [OK]. The image on the Viewer screen is saved.

**Printing Images**

Click in the toolbar or click "Print" in the File menu. The print dialog appears. Set the printing conditions and click [OK]. The image on the Viewer screen is printed full size.

**Displaying a Title on the Image that is Printed**

Click "Title Input" in the File menu. The "Title Input" dialog appears. Type the title to be printed in the input box and click [OK]. The title is displayed at the bottom of the image when it is printed.

- The ten most recent input titles are saved which allows you to choose a title using the pull down menu.

Setting the Date and Time Display Format

Clicking the "Date Display Format" will display the [Date Display Format] dialog. Set the format and delimiter and click [Apply] and then [OK].

- Display format
  - To set the date display format.
  - Selections:
    - MM/dd/yyyy (Month/Day/Year)
    - dd/MM/yyyy (Day/Month/Year)
    - yyyy/MM/dd (Year/Month/Day)
  -Delimiter
    - Selections: / (Slash), - (Hyphen), . (Period)